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Batch Invoicing 

You can generate invoices for all lines marked “Ready to Invoice” in a single operation, using the Batch Job 
Invoicing function. Run the batch invoicing function by selecting the Batch Job Invoicing menu option. 

Note: If this menu option is not available, you may need to add it at Setup > Menu Designer. 

 

Note: If the If the Allow invoicing of sub jobs from master jobs Company-level profile setting (see 
page 28) is enabled, the option Invoice sub jobs from master job is available at the top of the 
window. Ticking this option means that for each master job, a single invoice will be generated 
for the master job and all of its sub jobs. If the option is not ticked, a separate invoice is 
generated for each sub job. 

Searching Jobs 

The top section of the Batch Job Invoicing window contains the job filters (see page 49) available on the 
Search tab of the Job Management Screen. 

Set filters as necessary, then click Search to display all jobs that match the filter options, and that have lines 
that are set to the “Ready to Invoice” status. 

The tick boxes next to each box can be checked or cleared to include or exclude the job from the invoicing 
process. 
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Double-clicking on a job displays the individual lines of the job: 

 

Only lines with the status “Ready to Invoice” are displayed. If there are any problems with the job that 
mean it cannot be invoiced, these are displayed at the bottom of the window. 

Click the Goto Job button to open the Job Details window to view all information about the job. 

Click the PreAlloc Serial Nos button to assign serial numbers to the job. 

Check or clear the Selected option to include or exclude the job from the invoicing process. 

Processing Invoices 

To begin processing the selected invoices, click the Start Process button. 
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Specify the following details: 

Field Description 

Invoice Date Enter the date for all invoices in the batch 

Age Select the period that the invoices will be assigned to. 

Freight Select how freight charges will be applied. Choose from: 

 Same charge for all invoices - Enter the amount that will be charged to all 
invoices. 

 Let me apply charges to individual invoices - The next window will let you 
enter individual amounts for each invoice. 

 No freight charges. 

Update Job 
Status 

If you want to change the Job Status (see page 13) of all jobs invoiced in this batch, 
select a new status here; otherwise, select “<Don’t Update>“. 

Note: Only statuses that have the Jobs are complete characteristic ticked are 
available for selection here. 

Click the Create Invoices button to proceed. 

If you selected “Let me apply charges to individual invoices”, the Create Invoices button is replaced by a 
Continue Process button. Click this button to assign freight charges for each invoice using the following 
window: 

 

Enter an amount into the Freight column for each listed invoice (or leave the amount at $0.00). Once all 
charges are applied, click the Create Invoices button to proceed. 

When the Create Invoices button is clicked, the system generates all invoices, as well as assigning serial 
numbers and updating job statuses where relevant. You are given the option of printing some or all of the 
invoices. 
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Job Analysis 

The Analysis tab shows a pictorial view of the performance analysis of a job. It provides information about 
the profitability and status of a job and any sub jobs, drawn together on one special tab so that it can be 
restricted to management users only. All of this information can be derived from customised reports. 

The Analysis tab is a dashboard interface containing widgets that display job summary information. Select 
the Analysis tab: 

 

The right and left arrow buttons in the main toolbar allow you to switch from job to job. 

Note: As a dashboard interface, the Analysis tab can be fully customised - dashboard widgets can be 
added and removed to suit your needs. A blank Dashboard interface can also be added on a 
separate tab. By default, this Dashboard tab is disabled - you can turn it on by configuring the 
Hide tabs in Job management screen User-level profile setting (see page 31). 
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Documents 

The Documents tab of Job Management window is a continuation of the MYOB EXO Business 
Documentation features. The document manager allows job specifications, contracts, drawings, 
spreadsheets, project files and so on to be stored against a job/debtor. See the MYOB EXO Business online 
Help for instructions on using the Document Manager. 

 

The Documents tab toolbar offers a selection of buttons for creating, importing and exporting documents: 

Button Function 

 Document 
Manager 

Opens a search screen that allows searching of all documents in the database. 

 Create Letter Creates a letter (in RTF format) and pre-populates this with the customer 
address etc. On saving, you are prompted to store it in database. 

 Delete 
Document 

Deletes the document row currently highlighted in the grid. 

 Merge 
Document 

Requests a template file for a mail merge and allows creation of a mail merged 
output file. 

 Export File Exports the currently highlighted document file (that is stored in the database) 
to be exported to a standalone file on disk. 

 Import File Imports a standalone file into the database and creates a document manager 
entry. 
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When importing or creating a file for inclusion in the Document Manager, a window opens for the user to 
enter filing reference information. It also allows the entry to be a filing link to a document held separately 
on disk or to copy the document content into the database itself. 

Saving as a link will use minimal additional disk space but saving into the database may make retrieval on a 
WAN easier. 

History Notes 

History Notes are another form of documentation against a job. Unlike documents (see page 85) added to 
the Document Manager, a History Note only accommodates plain text and does not support rich text or 
images. 

 

The preview pane may be completely shown or hidden by clicking the Show Preview toolbar button. 

The test may be hidden but the message header retained by clicking the  icon in the message header 
band. 

Click the New History Note button (  ) to create an entry or double click an existing entry to edit. 
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Profile Settings 

The following User-level profiles affect the behaviour of the History Notes tab: 

 Allow delete of history notes (Default=True) - Uncheck to prevent deleting of history notes. 

 Date stamp on History notes can be selected (Default=True) - Uncheck to prevent the selection of 
date-time stamp on history notes, will always default to ‘now’. 

 History notes can be edited after saving (Default=True) - Uncheck to prevent retrospective editing 
of history notes once they are saved. 

Billing Schedule Tab 

The Billing Schedule tab shows all invoices related to the job. This includes: 

 invoices created from the Invoices tab (see page 76) 
 credit notes on invoices 
 billing schedules created for the progress billing feature (see page 112) 

Invoices can also be entered into the grid manually. 

 

Crediting Job Invoices 

To generate a credit note for an invoice on the job, right-click and select Generate Credit Note. Credit notes 
for job-related invoices can also be generated from the Transactions tab on the relevant Debtor account - 
right-click on a job invoice and select Generate Credit for Job Invoice. Once generated, credit notes also 
appear on the Billing Schedule tab. 

Crediting a job invoice completely reverses the transaction, including all stock movements and allocations. 
Credited invoice lines appear on the Invoice tab (see page 76), where they can be cancelled or written off 
as required. 
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Activities 

The Activities tab displays all activities associated with the job.   

 

An activity can be a Task or an Appointment: 

 A Task is a to-do item that must be completed in a specified time frame. 

 An Appointment is an event scheduled for a specific time. 

Activities can also be accessed via the Activity Search widget, which can be added to the Job Costing 
business flow menu. 

Note: When using the EXO Business CRM module, activities can be synchronised with Microsoft 
Outlook. Tasks are converted to Outlook Tasks and Appointments are converted to Outlook 
Appointments. 
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Creating an Activity 

Click the New Activity toolbar button to create a new activity (this button is available on the Activities tab 
and the Details tab). Alternatively, right-click on the Task Scheduler calendar in the time slot that you want 
to create the activity in. 

The Activity Window 

 

This is the window for entering new activities; use the table below as a reference for completing the fields 
in this window. 

Field Description 

Activity Type Select whether the activity is a Task or an Appointment. 

Type This is a user-definable classification for the activity. Select a type from the list, or 
select “Edit List...” to create a new type. 

Sync with 
Outlook 

If this box is ticked, the activity will be synchronised with Outlook whenever a sync is 
performed. If this box is not ticked, the activity will not be included in 
synchronisation operations. 

Subject Type a brief description of the activity and its purpose. 

Company 
Contact 

Assignment of an activity to a Company and/or Contact is optional. Where assigned, 
the activity will appear on the Activities tab of that company (Debtor, Creditor, Non 
Account) and/or the Contact screen. 

Note: When entering the Company name, use the search option by typing ? 
and pressing TAB. 
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Opportunity This field is only available when the EXO Business CRM module is licensed. Specify an 
Opportunity to associate the activity with. This field is optional. 

Label A label can be specified for the activity - this affects how it will appear on calender 
displays. 

Priority A priority (Low, Normal or High) can be specified for the activity. Low and High 
priority tasks are indicated with an icon on calendar displays. 

Status The Status setting has predefined list entries, but these may be edited or added to 
using the “Edit List...” option. 

For Tasks, clicking the Mark Complete toolbar button automatically updates this 
property to “Completed”. 

Assigned To 
Assigned By 

The EXO Business Staff members that the activity was assigned to and by. 

% Complete This property applies to Tasks only. Specify the percentage completion by entering a 
number or using the arrow controls. 

Clicking the Mark Complete toolbar button automatically updates this property to 
100%. 

Start Time 
End Time 

The start and end time for the activity. 

All day event If this is selected, the selections for the time of day will disappear as they are no 
longer valid. 

Reminder If you tick this checkbox, the system will pop up a reminder from the system tray 
after adding a reminder icon. Reminders can be enabled or disabled using the Enable 
Reminders option on the Tools menu of the Activity Search window/Dashboard 
widget. 

Show time as This property applies to Appointments only. Select how to display the time for this 
activity on the Task Scheduler. Choose from: 

 Free 

 Tentative 

 Busy 

 Out of Office 

Note: The relationship between the Status and % Complete properties is automatically maintained. 
For example, setting Status to “Completed” automatically updates the % Complete value to 
“100” and vice versa. 

Once all properties are configured, click Save and Close on the toolbar to save your changes. 
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Activity Recurrence 

Click the Recurrence button to set an activity as recurring and establish the frequency. 

 

Configure the recurrence options and click OK to assign this to the new or edited task. If you are editing an 
existing task and no longer need this recurrence to continue, click Remove recurrence to remove this from 
the calendar. 
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Resource Allocation 

Resource allocation allows resources such as staff and plant to be booked against a job. This can also 
generate appointments in the Microsoft Outlook calendar. 

Creating a Resource Allocation 

Resource allocations can be created in several ways: 

 Right-click on a job on the Job Overview tab (see page 50) of the Job Management screen and 
select Assign Resources. 

 Click the Resource Allocation button on the toolbar of the Details tab (see page 36) or Activities tab 
(see page 88). 

The Setup Job Resource Allocation window appears. 

 

Enter commitments for staff or plant, then click Save & Exit. 

You can see a graphical overview of all resource allocations on the Resource Overview (see page 94) tab. 

Note: When allocating resources, the system checks for over-allocations and checks that the Start 
and End Dates fit within the dates for the job. If either check fails, you are presented with a 
warning message. Two profile settings, Resources - Check for Resource Over-Allocations and 
Resources - Synchronise Job and Resource Dates are available to enable/disable these 
checks. 

Note: If the job’s Start and/or Due Date are changed, the resource allocation dates are 
automatically updated. 
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Creating Activities 

When a resource allocation is created, an Activity (see page 88) for the relevant staff member is 
automatically created in the EXO Business system. Activities can be viewed in the Activity Search widget, 
which is available on the main interface of both the Job Costing module and the EXO Business core. 

Note: If the resource is not associated with a staff member, the Activity will not appear on the 
Activity Search widget. It may be useful to set up a dummy staff account to associate non-
staff Resources with. 

Integration with Microsoft Outlook 

Individual allocations can be sent to Microsoft Outlook as calendar appointments by clicking the Create 
Appointment button. The job description is used as the body of the message. 

Note: After an Outlook appointment has been created, changing an entry in Job Costing or in 
Microsoft Outlook will not update the other entry. 

Resource Overview 

The Resource Overview tab available on the Setup Job Resource Allocation window (see page 93) and the 
Job Management screen (see page 48) provides a graphical representation of all resource allocations (see 
page 93) in the system. 

 

The tab is initially blank. To display resource allocations, select a time range from the Search on Resources 
Working control at the top of the tab and click Search. 

Note: The chart does not update automatically as job details are changed. To update the chart, you 
must click Search again. If the Show Resource Overview screen needs refresh warning User 
profile setting is enabled, a warning message alerts you when a job has changed. 
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The main section of the Resource Overview tab contains two areas: 

 An expanding list of all resource allocations matching the filtering criteria is displayed on the left. 
You can select a Show option to list only over-allocated resources, available (i.e. not over-allocated) 
resources or all resources. Click the plus or minus boxes next to a resource to expand or collapse 
the allocations underneath it. Double-click on a job’s name to view the Setup Job Resource 
Allocation window for that job (see page 93). 

 A chart showing the resource allocations on a calendar display. Resource allocations are 
represented as coloured bars. Over-allocated resources are highlighted in red. Double-click on a bar 
to view the Setup Job Resource Allocation window (see page 93) for the job that relates to the bar. 

You can drag the divider between these two areas to give more or less room for each. 

Navigating the Chart 

Use the arrow buttons on the bar at the top of the chart to scroll it left and right 

To change the zoom level of the chart, click the  and  buttons on the toolbar, or drag the bar at the 
top of the chart left (zoom in) or right (zoom out). 

Click the  button to center the chart on the currently selected resource allocation, and expand it to fill 
the width of the display. 

Click the  button to print a copy of the chart as it currently appears onscreen. 
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Serviceable Units 

About Serviceable Units 

Serviceable Units are an advanced feature of the Job Costing module. It is recommended that you consult 
with your EXO Business channel partner before implementing. 

Serviceable Units refer to items on which work may be required. These could be assets of the company 
running the Job Costing module or assets owned by their customers (perhaps previously sold to the 
customer). 

Serviceable Units can maintain a significant amount of information and history for the unit. To that extent 
they could be thought of as technically similar to Contacts but applying to asset items rather than people. 

A Serviceable Unit may optionally be associated with a stock item code and may even be associated with a 
serial number of that stock item. 

Serviceable Units may also have parent child relationships. 

Tip: When this Units feature is enabled, an extra Serviceable Units tab is available on the Debtors 
screen in the core EXO Business application. This tab lists any Serviceable Units relating to the 
Debtor account. 

Installing Serviceable Units 

Serviceable Units functionality is not installed by default. To add this functionality, a licence code for 
Serviceable Units must be acquired and installed. (The Serviceable Units feature does not have a separate 
executable; the functionality is included in the Job Costing module and the MYOB EXO Business core 
product when installed.) 

To install this licence: 

1. Open the MYOB EXO Business Configurator application and click the Add button on the Company > 
Registration section. 

2. Select Serviceable Units in the combobox and fill out the licence details supplied with your licence. 

 

3. Click Save. 
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4. You now have to add the required additional tables and fields (metadata) to your database. To do 
this, click the Launch Update button. The Database Update window shows EXO Serviceable Units in 
the top grid. 

 

5. Click the Update button at the bottom of the screen to complete the task. 

Serviceable Units functionality is now available in the Job Costing module. 

Configuring Serviceable Units 

Once the Serviceable Units feature has been installed, a Serviceable Units node becomes available in the 
Business Admin section of the MYOB EXO Business Configurator application. 

 

The sub-nodes under this node allow setup of a number of codes and descriptions for various properties 
that may be set for a serviceable unit. These include: 

 Unit Make 
 Unit Model (subsets of Unit Make) 
 Unit Class 
 Unit Usage Reading 
 Communication Types 
 Action Types 
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Tip: Makes, Models and Classes can be created from the Serviceable Units window if the Allow 
creation of new Make, Model and Class User-level profile setting is enabled. 

Serviceable Units can also be assigned one or more warranties. Set up warranties in the Configurator at 
Business Admin > Stock > Warranty. 

You can also set up the Job Costing menus to provide direct access to the Serviceable Units screen under 
the Accounts menu. This is done via the menu editor in the Configurator at Staff > Menus > Dropdown 
Menu. 

Creating Serviceable Units 

It is also possible to create a Serviceable Unit directly on the Job Management screen. This accommodates 
creating an entry for a unit when the first job for that unit is encountered, e.g. a new client brings their car 
in for servicing. If you have added the Serviceable Units option to your menu, you can create Serviceable 
Units independently of a job and then use them in a job at a later time e.g. selling a car and anticipating it 
being brought in for servicing. In either case the Serviceable Units screen is identical for both workflows. 

When the Serviceable Units feature is installed (see page 96), the Details tab (see page 36) on the Job 
Management screen shows an additional Serviceable Units sub-tab at the bottom of the screen. This allows 
pre-loading a list of units to be referenced on the job. New units may be created here or selected from the 
global list of units previously created (e.g. another service of a unit previously serviced). 

To create a serviceable unit, right click on the Serviceable Units sub-tab and select Create New Serviceable 
Unit. Alternatively, you can click the New button on the Serviceable Units search window. 

The Serviceable Units window appears: 

 

Most of these fields are self-explanatory however some comments follow: 

 Serial # only applies if the stock item is serialised (see page 111). 

 Both the Customer and Service Agent can be chosen from a search window of companies (list 
contains both Debtors and Creditors). 

 Bill code refers to a Bill of Materials code (optional). 
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A New Job button is available on this tab to create a new job (see page 36) from the Serviceable Units 
window. 

If the Allow creation of new Make, Model and Class User-level profile setting is enabled, a button is 
available on this tab to create Makes, Models and Classes from the Serviceable Units window. 

Warranties 

Warranties are optionally added by right clicking in the warranties grid and selecting Insert Warranty. 

Parent Child Units 

Serviceable units can optionally be organised into parent-child relationships. More than one level of 
relationship is permitted. 

To establish a unit as being a child of another unit, specify the parent unit for the Parent Unit field. 

From any unit the parent child relationship tree can be viewed by clicking the  toolbar icon. 

 

The current unit will be highlighted in the tree. Any other unit may be drilled to (opens another instance of 
the Serviceable Units screen). 

Additional Tabs 

Once the required information on the Details tab is entered, additional tabs become available. Most of the 
additional tabs on the Serviceable Units window work in a similar way to their equivalents in the Debtors or 
Creditors account screens and are documented in the main MYOB EXO Business online Help. They are listed 
here with brief descriptions. 

Contacts 

The unit may have changed hands during its lifetime. The Contacts screen can be used to create a list of 
contacts associated with the unit, therefore the item is another entity that may form a role with each of 
these contacts. 

Contact History 

This tab displays history notes for the serviceable unit. This operates in similar fashion to Debtors accounts 
but the history is tagged to the unit. 

Serviceable History 

This tab displays any transactions that are associated with the unit. A New Job button is available on this 
tab to create a new job (see page 36) from the Serviceable Units window. 

Notepad 

Free-form text can be entered against the unit. 
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Schedules 

A maintenance schedule can be established on this tab. This can comprise multiple entries. 

Click New Schedule to add an entry or double-click an existing entry to edit it. 

Docs 

This tab allows the Document Manager function to link external documents to the unit. 

Using Serviceable Units in Jobs 

The list of serviceable units entered on the Details tab (see page 36) of the Job Management window forms 
a short list of units that may participate in the job. 

One of these units will be the default. The default may be changed by right-clicking another unit and 
selecting Set as Default. 

Pre-existing serviceable units may also be added to the job by right clicking in the grid and selecting Assign 
Serviceable Unit and then selecting from a search screen. A unit may be removed from the job by right 
clicking it and selecting Unassign Serviceable Unit. 

Assigning Job Lines to Serviceable Units 

When the Serviceable Units module is installed, you can use the Select visible columns function of the 
ExoGrids on the Timesheet, Costs, and invoice tabs to show a Serviceable Units column. 

To change the serviceable unit on a line, enter “?” in this column to select a Serviceable Unit from the short 
list entered in the job details tab. A search screen of these units appears. 

Note: Lines added to a job will automatically be tagged to the default serviceable unit listed for the 
job. It is therefore recommended that you construct the serviceable units list on the Details 
tab of the job before adding lines to the job. 
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Reports 

A number of inbuilt reports exist in the Job Costing module. The Clarity library also contains additional 
reports and users may create additional ones using the Clarity designer. Your MYOB EXO Business trained 
professional will assist you in creating customised reports. 

The inbuilt reports and standard clarity reports are available under the Reports menu. 

Note: It may be necessary to edit the Reports menu at Staff > Menus in the EXO Business 
Configuration Assistant to make all of these reports available. 

Inbuilt Reports 

All inbuilt reports initially display to screen but may then be printed using the  toolbar button in the 
preview. 

Job Costing Report (see page 102) 
This report details all information recorded against a specific job, including any quotes. 

Job Status Report (see page 102) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against each job 
meeting the criteria of the job statuses selected and a grand total for each. 

Work In Progress (see page 103) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all 
jobs.  From here specific jobs can be selected.  Also from this report direct access is available to Job Details 
and the Job Costing Report. 

Staff Time Report (see page 104) 
This report displays details of hours spent on all jobs, the hourly rate and the total sell price of labour for 
each job for a staff member during a specified period of time. From this display the direct access is available 
to the Job Costing Report. 

Already Invoiced Report (see page 105) 
This report displays principal information of invoices created relating to a job. The actual invoices 
generated for this job can be displayed from this screen. 

Master Details Report (see page 105) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all sub jobs 
for the selected master job. From this display direct access is available to the Job Costing Report. There is 
also a Clarity version of this report. 

Clarity Library Reports 

Job Analysis (JCTAnalysis.CLR) 
This report runs for one job at a time and gives the invoice & job summary as displayed on the Analysis tab 
in the Job management screen.  The report also lists the line level markup and margin details for the Quote, 
cost and time tabs. 

Job Status Report (JCHStatus.CLR) 
This report has lots of run time parameters available like job status, due date range, completion date range 
etc and is similar to the inbuilt report. The jobs are grouped by status and each job can be drilled down to 
view the transaction line details along with a summarised markup% and margin% by the line status. 

Work in Progress (JCHWIP.CLR) 
This report lists work in progress for all jobs. No parameters are required. The user can drill down on each 
job to view the transaction line details. 



MYOB EXO Business Job Costing 

102 

Labour/Resource Analysis Report (JCTLAbour.CLR) 
This is similar to the inbuilt staff time report but can optionally list all staff (resources) in one report. 

Job with Invoices/Charges (JCTAlreadyInvoiced.CLR) 
This is similar to the inbuilt Already Invoiced Report. The report lists all the jobs that have been invoiced 
and the user also has the provision to view the invoice details for the job. 

Job with No Invoices/Charges (JCHUninvoicedjobs.CLR) 
The report lists all the jobs which have no invoices/charges and gives basic details of the jobs like the job 
code, title, account, job manager, due date, customer order number, status, the current WIP amount and 
the Current WIP time amount. 

Job Transaction Report (JCTTrans.CLR) 
This report shows the job at a line detail level and a summary by cost group and cost type. 

Master Detail Report (JCHMaster.CLR) 
This report displays totals of estimates, time, materials and invoiced amounts recorded against all sub jobs 
for the selected master job. 

Job Costing Report (JCHCost.CLR) 
This report can be printed for an individual job or a combination list of job statuses can be specified. 

Purchases Listing by Jobs (JCHPurchases.CLR) 
The report lists the various purchases that exist per job. The purchases are categorized as invoiced, costed 
awaiting invoice, instore awaiting costing and ordered awaiting delivery. 

Job Cost Summary (JCHSummary.CLR) 
The report gives summarised information like the time, materials, invoiced value, job value, realised profit 
etc for the selected jobs. 

Job/Quote Comparison report (JCTComparison.CLR) 
The report has been developed to give a comparison between the quotes and the actuals. It displays the 
details of quotes and actuals for each job in terms of quantity, cost price and selling price. It gives the 
comparison between quotes and actuals, in terms of percentage variance (+/-) , for various cost groups and 
cost types in each job. It also has a summary at the end of the report, which combines data from all the 
jobs and gives the comparison between the quotes and actuals for the various cost  groups and cost types. 

Job Costing Report 

To generate the report, select Reports > Job Costing Report from the main Job Costing menu. The system 
displays a search screen of Job headers. Select the job you want to print or preview. 
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Job Status Report 

To generate the report, select Reports > Job Status Report from the main Job Costing menu. The following 
window is displayed: 

 

Select the criteria for the report by using the controls on this window. 

Click OK to generate the report or Cancel to cancel the report. 
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Work in Progress Report 

To generate the report, select Reports > Work In Progress from the main Job Costing menu. The following 
window is displayed: 

 

The list of jobs can be filtered by Job Status or staff member. 

When the Auto Refresh option is ticked, changes to the filters are applied instantly. If this option is not 
ticked, you must click Refresh to display the new selection after changing filters. 

Double-click on a job to see the job details (see page 36). 

Right-click on a job to view job details or print the Job Costing Report (see page 102). 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and click Save. 

Staff Time Report 

To generate the report, from the Job Costing Main Menu: 

Select Reports > Inbuilt reports >  Staff Time Report.  The following screen is displayed: 
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Select the Staff Name from the drop down box (Resource name). This can be a staff member or other 
resource (e.g. plant item) that you have set up. 

Select the start and end dates using the drop down calendars which display. 

Click OK. The system will show a list of jobs and the time for the selected resource. 

 

Tip: To display the Job Costing Report for a job double click on the line of the job. The report maybe 
displayed behind the Staff time report.  To bring to the front click anywhere on any part of 
the report that is visible 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and click Save. 

Already Invoiced Report 

To generate the report, from the Job Costing Main Menu: 

Select Reports > Already Invoiced Report. The system will display a search screen of jobs. Highlight the job 
you want to print and click the Select and Close button to display the report. 

 

Double-click an invoice line to display the full invoice. 
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Master Detail Report 

To generate the report, select Reports > Master Details Report from the main Job Costing menu. The 
system displays a search screen of Job headers. Highlight the job you wish to print and click the Select and 
Close button to display the report. 

Double click the Master Job to be displayed. 

 

Note: If the job selected is not a Master Job the error message “No Data Found” will be displayed. 

Double click on a job line to display the Job Costing Report for that line. 

To print the report, select Print from the File menu. 

To save the report, select Save As from the File menu. Type an appropriate name for the file and click Save. 

Clarity Business Forms 

Clarity Forms (CLFs) are identified with specific functions within the Job Costing module. These are essential 
business forms that are part of the usual business workflow. In contrast, Clarity Reports (CLRs) can be 
placed on the MYOB EXO Job Costing menu or run via the command line. 

Each of the main job forms can have a drop down list presenting a variety of formats. 

These are known as a “form file lists” and are set up as comma-separated lists in the company profiles area 
of the EXO Business Configurator application. A good example is having several different options of quote 
layout available at printing time, e.g. detailed, brief etc. 

The following standard CLF files are available in Job Costing: 

Invoice.CLF 

The default Debtors Invoice form based on the DR_INVLINES and DR_TRANS tables. 

Will display “Copy” if it detects that it has been printed previously. Often a job costing user will link 
additional job information to the debtors invoice 
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JobPreview.CLF 

This form appears identical to Invoice.CLF, but the report itself is derived from Job Transactions and 
JOBCOST_HDR, as the DR_INVLINES and DR_TRANS entries have not yet been entered. Its purpose is to 
predict the appearance of the invoice before posting it to Debtors, allowing you to make alterations to the 
job. 

JobQuote.CLF 

Used to provide a printout of the job in a customer-oriented format. 

JobSheet.CLF 

Usually used as a sheet including work instructions and contact details for the job. 

Other Job Forms 

Form file lists allow you to create any number of job related business forms. Business examples might 
include Quality control sheets or a stock picking sheet. 
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Advanced Features 

Using Kits in Job Costing 

The Job Costing module can handle the inclusion of kitted items (Bills of Materials) in a job. Only Bills of 
Materials with the Type set to “Kit” can be used in Job Costing - “Build” and “Order Template” Bills of 
Materials are not available for selection. 

Tip: See the MYOB EXO Business Help under “Manufacturing” for full information on Bills of 
Materials. 

The benefits of this approach to kits are: 

 Kits can be moved as a complete unit from Quote tab to the Cost tab and Invoice tab. 

 A kit header line is displayed, which shows the cost and sell price of a kit within a job. 

 Components can be added to or removed from the kit after it is placed on the job and the cost and 
sell price will automatically be rolled up. 

 Kits can include non-default component options. These are lines that might represent optional 
variations to the kit. They are not added to the kit cost totals and are not added to the job unless 
selected afterwards.  

 Kit components can be serialised (see page 111). 

Note: Kits must be priced by component, with all component lines shown. The output item is a 
lookup code, and not a physical stock item. Hidden line price by total kits are not currently 
supported in Job Costing. 

Kit functionality is available in the Quote tab (see page 53), the Cost tab (see page 61) and the Invoice tab 
(see page 76) on the main Job Management screen. 

Adding a Kit to a Job 

You can select kits by entering a “.” (full stop) in the Code column and pressing ENTER. This opens a list of 
active kits for you to select from. Bills of Materials of types “Build” and “Order Template” do not appear in 
the list. After selecting a kit, you are prompted for the quantity of kits that you require. 

 

Note: Decimal quantities can be entered if the Quantities value at EXO Business Config > Essential 
> General Settings > Decimal Places in Numeric Values is set to a value greater than zero. 

When inserting a kit, the system will draw its default components into the tab you are on. A kit header 
displays in bold. Its cost and sell price is calculated from the sum of its component lines, which have a 
shaded background. Any change to these component lines will result in a change rolling up to the kit 
header. The job totals are calculated on the sum of the component lines of kits together with normal non-
component lines. 
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Note: Each kit has a unique number assigned to it when it is inserted onto a job. This is so that lines 
remain attached to their respective kit headers. Lines that are not part of a kit have the value 
-1. 

If the kit is priced by total, then after inserting the kit lines you will be asked to confirm the total price for 
the kit: 

 

The top option obtains its price from the Bill of Materials setup screen. This price is editable at run time and 
is apportioned across the kit lines (price rollup / rolldown). If the kit has an output code pointing at a stock 
item code, the system will test for the best price on that stock code and the result will be offered with the 
bottom option. This price is not editable but may be selected if desired. 

Note: The component lines of a kit may be hidden in the grid by ticking the Hide Kit Components 
checkbox. In this case, only the kit headers will show. 

Kit Options 

The following options can be accessed from the right-click menu on any kit line. 

Attach Line to Kit 

Right-clicking on a normal (i.e. non-kit) quote or cost line gives the option to attach that line to a kit. At 
least one kit must exist on the job before this function can be used. 

If you select this option, it will offer you a list of kits that exist on this job and if you choose to attach this 
line, then it will take on the kit ID of the kit chosen and the cost and sell prices for this line will add in to the 
kit totals. The line will be re-sequenced if necessary and added as the last line of the kit. 

Kit Functions 

When right-clicking on a kit header or one of its components, a different set of options relating to kits 
becomes available under the Kit sub-menu. 
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Change Copy To 

You can change the Copy to value on the entire kit or on single component line. If it appears that you can 
build a kit from the available stock on hand, you may choose to copy the entire kit straight to the cost tab 
when the quote becomes accepted and the job lines become activated. Alternatively, it may be necessary 
for one or more of the component lines to be purchased directly for the job. In this case, the Purchase 
Order line will remember the kit ID of the component being ordered, and when it is receipted and costed 
via inwards goods it will re-join the kit on the cost tab. 

Append Component Line 

This function allows the user to select additional lines from the Bill of Materials setup for addition to the kit. 
These are lines that have been marked as non-default and therefore were excluded when the kit was 
originally added to the job. These non-default BOM lines could be substitute items (used in conjunction 
with delete line of the original component) or common optional extras. 

Append Stock Item Line 

You can append a stock item line from the Stock file. Selecting this option displays the entire stock list in a 
search screen for selection. The item you choose does not have to be an item pre-configured as optional in 
the Bill of Materials. 

Substitute Component Line 

This function is only available when right-clicking on a component line in a kit on the Costs tab. Selecting 
this option allows you to choose a new component item to replace the selected item. 

Extra Kit information 

This function allows you to enter additional information for the kit. A periscope-style window is displayed 
to allow serial number information to be entered if this kit will make an output item: 

 

This information is for record keeping and may be printed on customer reports - the serial does not exist in 
the main stock serials list. If an asset is produced for the job and this is a serialised (see page 111) item, the 
serial number must be added there manually. It also does not flow through to serviceable units (see page 
96). 

Copy Bill Notes 

This function allows you to copy the notes established on the Bill of Materials setup screen into a narrative 
on the kit header line within the job. The narrative may then be customised as required and therefore the 
notes of the Bill of Materials may constitute a template. 

Duplicate Kit 

This function creates another instance of a kit already existing on a job, and is only available when right-
clicking on the header line of a kit. Copying a kit is different from inserting a kit from the Bill of Materials 
setup, in that it will copy any customisations of the kit (such as added lines etc). 



Advanced Features 

111 

Tracking Serial Numbers 

About Serial Number Tracking 

The Job Costing module offers advanced serial number tracking features. This includes the ability to pre-
assign serial numbers to work in progress prior to the invoicing stage, if your work in progress location is 
not zero and you are moving stock on entry to the job. Serialised lines can be copied from one job to 
another along with non-serialised lines by using the Copy button on the Quote and Cost tabs. 

To use these features, your work in progress stock location must be a valid stock location (i.e. not zero). 

The mode of serial tracking can be set on individual stock items. Job Costing supports tracking for Debtor 
Only (Out only), Creditor Only (In only) or Debtor and Creditor (In & Out Only). 

Note: Limited support is provided for Fully Tracked serials. For a serialised item tracked internally 
(including Fully Tracked), the system will prevent a line moving from the Quote tab unless a 
serial number is pre-assigned. Any mode that incorporates the Internal attribute can cause 
problems with the stock transfers to and from WIP unless the serial is known at all steps. The 
pre-assignment requirement means that the serial number must exist in stock before the 
Quote line can be sent to another tab. This particularly precludes creating a Purchase Order 
inside a job for such an item. 

To use these features you must enable two company-level profile settings in the MYOB EXO Business 
Configurator application: 

 Enable serial number tracking - This setting gives overall control over the enabling of serial number 
tracking features in all modules. 

 Allow serial number assignment - If this setting is not enabled, only the invoice production will 
prompt for serial numbers. 

Using expiry dates is optional. These can be used for Warranty or shelf life limits. 

Serial Numbers and the Quote Tab 

MYOB EXO Business has a profile setting that allows actual costs to be recorded on individual serial 
numbers of an item. This is not a form of FIFO stock but does record the cost that the serial was receipted 
to stock with. This can be useful for high value items where shipments vary significantly in cost. In such 
cases, when quoting, it may be desirable to know the individual serials cost in terms of negotiating a selling 
price. 

The Quote tab has the ability to display a Pref. Serial# (preferred serial number) column using the Select 
visible columns right-click menu option for the grid. This allows the operator to choose an existing serial 
that is in stock and not associated with another job. Enter the usual “?” to search in this column will display 
a list of serials that: 

 Are in stock 
 Are not pre-assigned to another transaction (e.g. Job, invoice or Sales order) 
 Have not been selected as a preferred serial in another job line 

Note: This third point makes this list different from just the unassigned serials that occur elsewhere 
in EXO Business products. Using a serial number in this indication of preference does not lock 
the serial number from being used elsewhere in the processing like pre-assignment does. 
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Serial Numbers and the Cost Tab 

If serial numbers are enabled and assignment is allowed, then whenever you save the job, the system 
detects if you have any have serial numbered items on the Cost tab (see page 68) that have not yet been 
assigned a serial number and it will give you the opportunity to assign them. This includes serialised items 
that have been copied from another job using the Copy button on the Cost tab. If you have already 
assigned the serial numbers but want to remove or re-assign them you can call the Serial number 
assignment screen by clicking the Save and Prompt for Serial Numbers button (  ). 

Note: Serial number pre-assignment does not apply to lines that have not left the Quote tab (see 
page 111). 

Ultimately you will be forced to reconcile any outstanding serial numbers before you invoice these items. 

Serial Numbers and Purchase Orders 

If an item is tracked into store (Creditor) and goods are receipted into work in progress via inwards goods, 
the serial number will automatically be assigned to the job without need for further user intervention. 

If a job line containing a serialised item is cancelled (i.e. its Status is set to “X”), then the serial number 
associated with it is automatically de-assigned and released back into the free serial number list. Cancelling 
the transaction moves the stock out of work in progress and puts it back into the default stock location. 

Progress Billing 

About Progress Billing 

Progress Billing is sometimes also known as contract invoicing. 

Note: This is an advanced feature. It is recommended that you consult with your MYOB EXO 
Business channel partner before implementing. 

Progress Billing allows a group of job cost lines to form a Billing Schedule entry. 

An extension to progress billing is retentions. Retention is a value proportion of the progress bill which the 
client withholds from payment as a quality guarantee on the job. It becomes due for payment, and is billed, 
at a later date. 

When Progress Billing is enabled, the Billing Schedule tab (see page 88) appears on the Job Management 
screen. 

Billing Schedules 

Progress Bills are charged through a lookup stock item whose code starts with the “@” character. One of 
these will have been automatically created in your database. 

Generating Billing Schedules 

A progress billing entry may be created in several ways: 

 On the Billing Schedule tab (see page 88), enter details directly into the grid. 
 On the Quote/Budget tab (see page 53), the Marked Lines submenu will have an option to 

Generate Billing Schedule. 
 On the Timesheets (see page 61), Costs (see page 68) and Invoice (see page 76) tabs, the Marked 

Lines submenu will have an option to Allocate to Progress Invoice. 
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From the Quote tab 

The Generate Billing Schedule function allows a schedule for billing to be created at the time of quote. 

1. On the Quote tab, mark some lines that have not been sent to another tab. 

2. On the right-click menu select Marked Lines > Generate Billing Schedule. 

3. A schedule window will appear for you to enter a description and due date (which is the date when 
the invoice is due to be created). The values are summed from the contributing lines and cannot be 
altered. 

 

4. Click OK. 

If you want additional schedules then you can repeat this for additional groups of marked lines. 

These schedules will now appear on the Billing Schedule tab. 

 

You can also create schedules manually on the Billing Schedule tab by pressing the down arrow on the grid 
and manually entering in a new schedule. You can specify the value manually or leave it at zero pending 
allocation of work in progress at a later time. 
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Adding Information 

Additional information can be added to the schedule by completing the following columns on the Billing 
Schedule tab: 

Field Description 

Due Date The anticipated date for creating a tax invoice. 

Allow Allocation Select “Y” to allow work in progress lines to be allocated to the billing 
schedule. If “N” is selected, the schedule will not appear on the Progress 
Invoice window for allocating lines. 

GL Code The General Ledger code the schedule is to be billed to. 

Note: The Enable display and override of GL code from stock item 
profile setting must be enabled for the GL code to flow 
through to the invoice; otherwise by default the invoice picks 
up the GL code for the stock item. 

Percentage Complete Enter a percentage to allow monitoring of progress of WIP relative to the 
schedule. 

Allocating Work in Progress Lines 

Work in progress lines on the Timesheets (see page 61), Costs (see page 68) and Invoice (see page 76) tabs 
can also be allocated (added) to a billing schedule. Mark the required lines and from the right click menu 
select Marked Lines > Allocate to Progress Invoice. 

The system will prompt for the progress invoice to which the lines are to be added. 
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Click OK. The following window appears: 

 

This window lets you confirm which lines you want to add to the invoice. The top section of this window 
displays the lines that you selected on the Timesheets, Costs or Invoice tab; the bottom section displays the 
lines that are currently included on the selected invoice. Select the lines to add (by default, all lines are 
selected), then use the toolbar buttons to allocate them to the invoice. 
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Invoicing Billing Schedules 

Pro-forma Invoices 

Pro-forma invoices may be generated from each of the scheduled bills. Highlight the schedule that you wish 
to action. The option to generate pro-form invoices is available in two places: 

 Select Progress Billing > Proforma Invoice from the toolbar on the Billing Schedule tab (see page 
88). 

 Right click on a line on the Billing Schedule tab and select Proforma Invoice. 

The invoice will print, and a number will be allocated and shown in the Proforma Invoice column. 

Tax Invoices 

The Progress Billing dropdown and right-click menus also have options for creating a true tax invoice 
(Create Invoice). 

Note: Be sure to set the appropriate General Ledger code in the GL Code column before invoicing. 

Selecting this option opens the standard EXO Business Invoice Entry window. After invoicing, the invoice 
number will show in the Invoice No column and the background colour of the row will be green. The right-
click menu now includes an option to View Invoice. 

Retentions 

Retentions are an additional option that may be used to extend the functionality of progress invoices. Like 
Progress Billing, retentions are not activated in a standard Job Costing install and therefore associated 
properties do not appear by default. After consultation with your EXO Business channel partner, they will 
be able to activate this feature for you. 

Retentions apply in some industries, such as the building industry, where the customer retains a certain 
portion of the bill to ensure that any follow up work required for merchantable quality is provided. From an 
accountant’s perspective this can be a complex topic and advice is recommended before implementing this 
option. 

Default Retention Rates 

You will need to add the menu item Setup Retention Rates to the menu of your Job Costing main form via 
the menu editor in the MYOB EXO Business Configurator at Staff > Menus > Dropdown Menu. This will 
allow you to set the default retention levels for use in your database. 

Select this menu item to establish the base rates appropriate to your industry. 
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Creating Retentions in the Billing Schedule 

When retentions are active, additional columns are available on the Billing Schedule tab and a Retention 
Levels button appears on the toolbar: 

 

To set the retention values for a row, highlight the row and click the Retention Levels button. The Job 
Retention Levels window appears: 

 

Either click Set to Defaults to pick up the base rates established earlier or enter the default levels and rates 
manually. Click Apply. 

The retention rates and computed dollar amounts appear in the various Retention columns on the Billing 
Schedule tab. These columns are not editable, but may be reset using the Retention Levels button again. 

When the tax invoice is created for a row containing retentions, the retention value shows as a deduction 
on the invoice. This utilises a stock item with code RETENTION (this item is automatically created in your 
database). 
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Realising a Retention 

Realising a retention means invoicing that retention. To realise a retention, right-click on the cell value of 
the retention you want to realise, then select Realise Retention. 

The Realise Retention window opens, allowing you to adjust the value you wish to invoice. 

 

Click OK. An Invoice window appears. 

Complete this in the normal manner. The cumulative retentions value will now appear in the Retention 
Realised column. Repeat the process when further retentions need to be realised. The value in the popup 
will default to the balance due. 
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Custom Buttons Overview 

Job Costing incorporates custom buttons that can call an executable file (a file which will run another 
portion of MYOB EXO Business) and pass it the connection name, user name, password and job 
number. This could be a Job Costing related program, or a special report such as a Clarity report. 

 

It is possible to define up to nine extra buttons each of which can execute external applications or run 
reports. Each button is defined by two properties: 

 The name or caption to appear on the button, or when the mouse pointer hovers over the button 
(limited to 15 characters). 

 The action to be performed. To run a Clarity report, only the report file name is required; otherwise 
normal parameters are passed automatically, i.e. <filename.exe> Aliasname – Login – Password – 
Jobno parameter 

Custom buttons are set up using the MYOB EXO Business Configurator application, where they are 
configured as User-level profile settings (see page 31). 

Button Appears On Common Use 

1 Search Screen Job List (status) report 

2 Details Screen Single Job Summary Reports 

3 Details Screen Single Job Summary Reports 

4 Quote/Budget Screen Print Quotation 

5 Time Screen Single Job Time Sheet Summary 

6 Costs Screen Single Job Materials Summary 

7 Purchases Screen Purchase Lines report by Job 

8 Invoice Screen Invoice Preview 

9 Performance Screen Custom Performance summary 

Consult an EXO Business Partner for more information on settings these buttons. 
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Frequently Asked Questions (FAQs) 

How should I account for Stock on hand value and Work in Progress in my General Ledger? 

At this time, the only practical method of accounting for the value of stock contained in Work in Progress 
(WIP) is the periodic posting method. You then have a choice as to how physical stock is tracked within the 
system. 

You may nominate a selected stock location as WIP. As stock is used on the job, MYOB EXO Business will 
create a stock transfer from the selected stock location, to the nominated WIP location. Direct purchases 
will be inserted directly into the WIP Location. 

You can choose when the transfer of value actually takes place: at time of entry (recommended), or at time 
of invoice. 

One problem with tracking WIP as just another stock location is that sometimes you may never invoice the 
stock directly. It will never therefore be removed from the WIP location in the stock record. 

Another problem with this method is that you must remember to exclude the WIP location from your 
physical stock valuation. 

The true WIP value includes items that are non-physical such as labour and overheads. So looking at the 
value of physical stock in the WIP location can be misleading also. 

Sometimes it can be hard to ascertain the amount of free stock available because the WIP location is 
counted as free by default. By enabling the Exclude from Free Stock setting for the WIP location, you can 
exclude it from the free stock calculations. This setting is not suitable if you are using serialized items on 
jobs. 

Does Job Costing support a FIFO-style stock costing method? 

No, this method is not fully supported. 

Can I manually type into the Contacts field on the job, rather than setting up a Contact on the Debtors 
account? 

It is not possible to edit the Contacts field on a job header directly, as this is a lookup field to the table of 
Debtor Contacts. You can only add to or pick from the list of Contacts. We suggest that you enter text 
Contact references in the Our ref field, or the Notes sub-tab. 

Why can’t I modify a transaction on the Costs or Timesheets tabs once it is “Ready to Invoice”? 

Once a transaction has been transferred to the Invoice tab (see page 76), all alterations must be made to 
that transaction via the Invoice tab, or the transaction must be returned to the source tab by using right-
click menu. The transaction is locked for editing if its status is “R” - it must be returned the tab of origin 
before it can be modified. 

How can I speed up the entry of transactions? 

Use the default Cost Types (see page 20) by stock item as much as possible, as this speeds up entry. Select 
visible columns and the order of these columns on the transactions entry grids with care. 

Can I post Creditors Invoice lines directly to jobs without using Purchase Orders? 

It is possible to enter lines directly from Creditors Invoices to jobs; however you cannot assign Cost Types 
(see page 20) and Cost Groups (see page 18) at this time. The default Cost Type/Group will be assigned 
based on the stock item defaults. 

Can I post Inwards Goods receipt lines directly to jobs? 

It is highly recommended that you receipt goods via the Inwards Goods process in MYOB EXO Business, as 
FX and landed costs are taken into account this way. This is a far more accurate method than simply 
receipting stock without any reference to the costs of getting the goods into store. 
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Can I use line discounts and special price rules in Job Costing? 

Yes. Best price rules will apply in Job Costing unless they are disabled via the Best price and discounting in 
Job Costing company-level profile setting (see page 28). You can enable or disable the Discount column 
using the grid column controls by right-clicking on the transaction entry grid. 

The pricing policy for specific Debtors is applied to PRICE 1-N for the price number that that customer is 
associated with. 

Can I track stock batches and serial numbers via Job Costing? 

Batch number features are not enabled in Job Costing at present. 

Full pre-assignment of Debtor serial numbers (see page 111) is possible and multiple serial numbers can be 
applied to a single line. Not all serial number types are supported. There are issues with Fully Tracked serial 
numbers, as this places heavy restrictions on the ability to save stock transactions on a job before you know 
what the serial numbers are going to be. 

Can I have sell prices in Foreign Currency within a Job? 

Yes, this feature was added in the EXO Business 6.190 release. 

Can I use the New Purchase Order button on the Purchases tab to create multiple Purchase Orders 
without returning to the Purchases tab after each one? 

If you click the Purchase Order button on the Purchases tab (see page 74), this will automatically lock the 
job code in to the reference field as the default job code for each line. If you save this order and click New 
from the Purchase Order search screen, the job reference will be locked, but the job code will not be 
passed into it as default. Our recommendation is to use Purchase Orders off the main menu and enter the 
job code – or always go back to the job and click the Purchase Order button if you want to create multiple 
Purchase Orders for a job. 

Why do I keep getting the wrong job resource when I enter the initials on the timesheet? 

If you have two initials defined in the resource table that are the same, the system will always pick the first. 

Can I post to different Cost of Goods accounts in my GL depending on the type of transaction rather than 
the stock code used? 

It is not currently possible to post to Cost of Goods GL accounts from Cost Types in Job Costing. It is only 
possible to post via the Stock Item. This means that you cannot have profit statement by Job Type in the 
General Ledger, because all raw materials can be posted to only one Cost of Goods account. We 
recommend Job Profit reporting using Job Cost reports. 

How do I avoid variances in the Creditors Invoice cost after I have receipted stock onto a job? 

This problem should not occur if the Inwards Goods process is followed correctly, because the stock is not 
posted to the job until after it has been formally costed. 

I have a written a report, and have found a lot of meaningless transactions on a Job 0 that I don’t have. 
How did these get there and how do I clean them out? 

Previous versions of Job Costing posted all non-job-related Purchase Order lines to a non-existent Job 0. 
These lines were lines that were not posted to jobs. While they do not affect the system normally, they may 
appear as phantom lines in custom reports. These can be removed by executing the SQL scripts: 

DELETE from JOB_COST_LINES WHERE JOBNO = 0 

DELETE from JOB_TRANSACTIONS WHERE JOBNO = 0 

Can I use the One-off Stock Items features in Job Costing? 

One-off Stock Items cannot be created by pressing CTRL+O on job lines. To create a One-off Stock Item you 
must enter “?” and then choose the Copy Item button on the search screen. 
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What are the Length, Width, Depth and Quantity fields for? 

These were written in for a specific industry group. The idea is that Length, Width Depth and Quantity are 
all 1 by default and therefore should have no effect unless they are enabled by making them visible and 
typing a quantity other than 1.00 into them. Another field, TOTAL_QUANTITY, exists on the job line to hold 
the sum of these “volumetrics”. This is a calculated field and cannot be edited by the user. It should be used 
for all calculations and reports. Normally users will only enter values into the Quantity field as this will 
always appear on reports and business documents. 

Job Costing volumetric measurements can also cater for fixed dimensions on stock items. 

If an extra field X_LENGTH is added to the stock item, the Length field in the Job Costing transaction will 
automatically be populated with this value. The default value of the extra field should be 1.00. 

If an X_WIDTH field is added to the stock item table, the Width field is populated with this value on entry. 

If an X_DEPTH field is added to the stock item table, the Depth field is populated with this value on entry. 

Examples might include standard stock lengths and widths for sheets of plasterboard or roofing irons where 
the resulting price on the transaction is by total square metre. 

How can I use the paste to grid functionality in the Quote tab? 

The Quote tab (see page 53) has the ability to accept lines pasted from a spreadsheet if the spreadsheet is 
in a compatible format, i.e. the columns are in the same order and values are compatible. 

Pasting of advanced kits is supported in a very comprehensive but very specific fashion, not as a generic 
feature. 

Can I add extra fields of my own design to Job Transaction lines? 

As in the rest of the MYOB EXO Business system, you can use the Extra Fields function to create and add 
database fields of your own design to a job header, and add all the necessary controls on the job details 
screen to allow you to input and maintain the information. However, Job Costing also allows you to do this 
with transaction lines. 

I am receiving the following error message saving a timesheet transaction: “Hours on a timesheet cannot 
be zero.” What does this mean? 

When you enter a transaction into the timesheet and Job Costing has been configured such that you enter 
the number of time units manually (as opposed to start time and end times) then you must enter a value 
into this field before the transaction can be saved. 
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How is the sell price determined if I purchase goods directly for a job? 

Using the following process: 
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